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Better Ul Elements

The Better Ul Elements are extending the Ul elements of Unity's uGUI framework by additional
functionality.

1 WORKFLOW: MAKE BETTER

Better Ul is designed to extend uGUI where needed. It is also possible to include it in existing projects
and extend certain Ul elements with a simple workflow.

Wherever you realize needing some more functionality on an Ul element just click the options-gear-
wheel on the component and click the "# Make Better" option.

Reset

Remowve Compeonent
Move Up

Move Down

Copy Component

Paste Cornponent As Mew

Paste Component Values
Edit Script

& Make Better

This will replace the current Ul Element by its "Better" pendant. It will keep all the values of the original
uGUI objects properties. It will also search for references to that object in the hierarchy. Any found
references to that element will be replaced with references to the "Better" element, so you don't have
to worry about manual changes in the scene after making an element "better".

Please note that only references in the scene will be replaced. If you make a prefab "better" which is
referenced by another prefab, the reference will get lost and you have to re-assign it manually.

2 Ul AND LAYOUT ELEMENTS OVERVIEW

The following table is showing a short overview about how a "Better UI" element extends the uGUI
element.

A detailed description is documented later.
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Better
uGui
uGUI Element ui Better Ul Element What is better
lcon
Icon
Selectable Better Selectable Better Transitions
0K Button @ Better Button Better Transitions
v Dropdown u Better Dropdown Better Transitions
Sliced Mode:
= Keep Border Aspekt Ratio
'-. Image @ Better Image = Border Scaling
d Tiled Mode:
= Border Scaling
) _ Better Transitions
Tl WEREREIE Better Input Field Additional Placeholders
1 Scrollbar u |Better Scrollbar Better Transitions
] Scroll Rect .; Better Scroll Rect Horizontal- / Vertical start position
a> Slider n Better Slider Better Transitions
Font Sizer (Screen Dependent Size
Text Better Text Modifier)
Fitting Modes
Better Transitions
v Toggle Better Toggle Additional Toggle Transitions (On /

Off)
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Grid Layout

* Group

Better Grid Layout
Group

Resolution Dependent Size
Modifiers:

= Padding Sizer

= Spacing Sizer

= Cell Sizer
Constraint: Fixed Column- / Row
Count

=  Fit (Cell size adjustment to

fit in layout group)

Horizontal
"I Layout Group

Better Horizontal
Layout Group

Screen Dependent Size Modifiers:
= Padding Sizer
= Spacing Sizer

Vertical Layout
Group

Better Vertical Layout
Group

Screen Dependent Size Modifiers:
= Padding Sizer
= Spacing Sizer

TransformScaler

Screen Dependent Size Modifiers:
= Scale Sizer

3 BETTER TRANSITIONS

Transitions are used to give feedback for the different states of an object. An selectable ui element can

have the following states:

=  Normal

When it is just displayed on the screen without having any interaction right now

» Highlighted

When the object is in Focus (Mouse is above or the last element where a pointer down action has

been performed)

=  Pressed

When the pointer is currently pressing the element

= Disabled

When the element is not interactable

Ul Element with "Better Transitions" can have a uGUI transitions as well as additional transitions. These
additional transitions can affect any number of objects with different kinds of transitions. Also, there are

more options for "Better Transitions" than for the uGUI transition.
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Example: If you need a button where the background color should change as well as the text color you
could add a "Better Transition" for the Text object.

The Following Better Ul Elements providing Better Transitions:

= Better Selectable
= Better Button

»= Better Dropdown
= Better Input Field
= Better Scrollbar

= Better Slider

= Better Toggle

3.1 How TO ADD A BETTER TRANSITION
To add a "Better Transition" to one of the Ul Elements perform the following steps:

Increase the Count of Better Transitions by one

Select the Mode of the Transition (see description for the modes below)
Drag and Drop a valid Target in the respective Object Field

Define the states for every transition

PwNhPR

~ MNone

Color Tint

Sprite Swap

Animaticn
Object Activeness
Alpha

3.2 TRANSITION MODES

The following modes can be selected.

It is possible to affect the same object with several transitions. You should make sure not to use the
same transition mode for the same target more than once.
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3.2.1 ColorTint

Colorizes the Target Graphic for each state. (Similar to the uGUI Color Tint transition)

You should make sure that the Target Graphics color is white unless you want to have mixed up colors.
3.2.2  Sprite Swap

Changes the Sprite of the Target Image for each state. (Similar to the uGUI Sprite Swap transition)

The Fade Duration provides information about if and how long a state transition is animated.

3.2.3 Animation

Triggers the given Trigger Names on Target Animator for each state. (Similar to the uGUI Animation
transition)

3.24 Object Activeness
Can set Target GameObijects active or inactive for each state.
This cannot be previewed outside play mode.

Make sure the Ul Element itself doesn't become inactive through this transition because it cannot
enable itself again once it is inactive (actually it doesn't do anything anymore when inactive).

3.25 Alpha
Changes the transparency of Target Graphic for each state. (Similar to Color Tint transition)

The Fade Duration provides information about if and how long a state transition is animated.

4 SCREEN DEPENDENT SIZE MODIFIERS

There are various "Sizer" objects on certain Ul elements. They are used to scale certain values
depending on the used resolution (and / or DPI).

Every "Sizer" contains the following values:

»= Current Value: The last calculated value for the current resolution / dpi. Cannot be changed
directly because it is calculated.

»  Optimized Size: The fixed size for the optimized resolution / dpi

* Size Modification (Foldout)
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= <X>x<Y> @ <Z> DPI [change]: The optimized resolution / dpi for this unity project.
by pressing the change button the Resolution Monitor object will be selected where the
global Optimized resolution / dpi can be changed (see there).

= Min Size: The minimum size (if the calculation for a resolution / dpi would return a
lower value, the Min Size is used instead)

= Max Size: The maximum size (if the calculation for a resolution / dpi would return a
higher value, the Max Size is used instead)

=  Size Modification (List): Contains Setting entries of how the size should be calculated.
If the list is empty, the size will always be the optimized size.
If there is more than one entry, the middle is calculated.

Spacing Sizer

Pixel Height

4.1 Size MODIFICATION SETTINGS
Each Modification Setting consists of two values: Mode and Impact.

The Mode defines which Screen-values should be used to calculate the actual size (in the very most
cases "Pixel Height" or "Pixel Width")

The Impact defines how much the modification settings affects the change of the size (doesn't affect at
zero; affects totally at one).

Depending on the current screen resolution / dpi size value is recalculated using the modification
settings.

Here are the different Modification Modes in detail.
4.1.1 Pixel Height

If the height of the current resolution is smaller than the optimized resolutions height, the size will get
smaller.
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If the height of the current resolution is greater than the optimized resolutions height, the size will get
bigger.

4.1.2 Pixel Width

If the width of the current resolution is smaller than the optimized resolutions width, the size will get
smaller.

If the width of the current resolution is greater than the optimized resolutions width, the size will get
bigger.

4.1.3 Aspect Ratio
The aspect ratio is calculated the following way: aspectRatio = width / height

If the aspect ratio of the current resolution is smaller than the optimized resolutions aspect ratio, the
size will get smaller.

If the aspect ratio of the current resolution is greater than the optimized resolutions aspect ratio, the
size will get bigger.

4.1.4 Inverse Aspect Ratio
The inverse aspect ratio is calculated the following way: aspectRatio = height / width

If the inverse aspect ratio of the current resolution is smaller than the optimized resolutions inverse
aspect ratio, the size will get smaller.

If the inverse aspect ratio of the current resolution is greater than the optimized resolutions inverse
aspect ratio, the size will get bigger.

415 Dpi

DPI means "Dots Per Inch" or in other words "how many pixels can fit next to each other within one inch
on the current screen".

If you choose to scale in DPI mode, the physical size will always stay the same.
Example: If you have an object which displays a ruler and you adjust the correct scale for the optimized

resolution / dpi and you scale that object by using a sizer which modifies the size by dpi, the ruler will
have the correct distances on every device (if the device provides the correct dpi for its screen).

10



s ul o THERABYTES
L

4.2 Size MODIFIER TYPES

There are Size Modifiers for the following types:

= Float
= Vector2
= Vector3

=  Margin (Wrapper for RectOffset — used for Padding of Layout Groups)

For each dimension of a type (x, v, z or left, right, top, bottom) there are modification lists. If you want
to adjust the size uniformly make sure to set the same mode to all dimensions (e.g. set all to "Pixel
Height").

4.3 COMPONENTS WITH SIZE MODIFIERS
There are some Better Ul elements using the Size Modifiers:

* |mage
= Sprite Border Scale (Sliced & Tiled mode)
= Text
= Font Sizer
*  Grid Layout Group
= Padding Sizer
= Spacing Sizer
= Cell Sizer
» Horizontal- & Vertical Layout Group
= Padding Sizer
= Spacing Sizer

Additionally, there is an extra Component using a size modifier:

=  Transform Scaler
= Scale Sizer

11
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Z Transform Scaler (Script) @
Scale Sizer
(2, 2.13:
Z1

1080 x 1920 @ 96 DPI

Pixel Height

7 Modification
List is Empty

The Transform Scaler affecting the scale of the object. You should use it wisely. Scaling inside the Ul
often leads to unexpected positions and sizes of objects.

As a rule of thumb, you should use the Transform Scaler only for objects which has no children or no
complex children hierarchy.

5 SPECIAL Ul ELEMENTS

In addition to the "Better Transitions" and Size Modifiers some elements also have custom behavior.

5.1 BETTER IMAGE
The Better Image has advantages only in Sliced and Tiled mode.
5.1.1 Sliced

Keep Border Aspect: Scales the borders of the image to preserve their aspect ratio if necessary.

12
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UGUL border 15 shrinked

Better Ul

Sprite Border Scale: Scales the borders of the image using the settings inside the sizer. Also scales the
aspect ratio for the "Keep Border Aspect" option.

512 Tiled

Sprite Border Scale: Scales the size and border of the tile-pattern. If set up correctly the same amount of
tiles are shown at any resolution.

5.2 BETTER INPUT FIELD

In addition to the Better Transitions the Better Input Field has a list of of Additional Placeholders.

These Placeholders are Graphic objects (Text, Image or Raw Image) which are visible (enabled) when
there is no text entered in the input field and invisible (disabled) as soon as the user starts to write.

13
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Example: If you need e.g. an image as a placeholder as well as a text, add them to the Additional
Placeholders list.

5.3 BETTER SCROLL RECT

uGUIs Scroll Rect has the odd behavior to always jump somewhere in the middle of the vertical scroll
area on start.

The Better Scroll Rect provides two extra fields: Horizontal Start Position and Vertical Start Position.
The Scrollbar will jump to that (relative) position on start.

If you have horizontal / vertical Scrollbars assigned, you can inject the current value of them by a click on
the button below the respective start position slider.

« Better Scroll Rect (Script)
Content ++»Content (Rect Transform)
vy
vy
Elastic
0.1
vy

0.135

nport (Rect Transform)

de And Exp:

List is Empty

Horizontal Start Position
Vertical Start Position

From current Vertical Scrollbar value

In the background a Coroutine is started which waits a frame before changing the positions. Therefore it
is not possible in this version of Better Ul to hat the position change in edit mode.

14
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5.4 BETTER TEXT

Better Text can Scale the Font Size according to the current resolution / dpi with the Font Sizer.
It also has three kinds of Fitting Modes:

5.4.1 Sizer Only

Will just affect the font size of the text using the Font Sizer. If the size becomes too large, parts of the
text may be cut off or overflow the bounds (depending on the overflow settings).

5.4.2 Stayin Bounds (default)

The size is affected by the Font Sizer. But if the text wouldn't fit inside its bounds anymore the size is
reduced to fit in.

5.4.3 BestFit

Equal to the "Best Fit" option of uGUI. The text will grow or shrink to fit inside the bounds. The Min Size
and Max Size values of the Font Sizer are used to avoid too small or too large font sizes.

5.5 BETTER TOGGLE

In addition to the "Better Transitions" there are "Better Toggle Transitions (On / Off)".

They function the same way as "Better Transitions" but have the states "On" and "Off" instead of
"Normal", "Highlighted", "Pressed" and "Disabled". Accordingly they are triggered when the "Is On"

state of the toggle changed.

It might lead to unexpected behavior if you assign the same kind of transition with the same target to
"Better Transitions" and "Better Toggle Transitions".

5.6 BETTER GRID LAYOUT GROUP

Besides the Size Modifiers for Padding, Spacing and Cell Size, there is an extra option if you select "Fixed
Column Count" or "Fixed Row Count" as a constraint: Fit

If "Fit" is enabled, the cell height (fixed row count) or cell width (fixed column count) are stretched or
shrinked to exactly fit all together inside the parent while respecting the size of the padding and spacing.

15
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Resolution Monitoring

6 RESOLUTION MONITOR

The Resolution Monitor is a scriptable object which holds the optimized resolution / dpi and which
tracks changes of the resolution and notifies certain scene objects about a change.

The Resolution Monitor object can be found in your Unity project at
"TheraBytes/Resources/ResolutionMonitor". There you can set the optimized Resolution / DPI for your
project.

If there is no ResolutionMonitor object for some reason, you can create it manually by selecting
"Window > Thera Bytes > Force ScriptableObjectSingleton Initialization" from the menu bar of Unity.

@ Inspector

The following static properties can be accessed:

»= ResolutionMonitor.OptimizedResolution: A Vector2 indicating the resolution which is used to
build the UI.

» ResolutionMonitor.OprimizedDpi: A float value indicating the optimized DPlyou are working on.

*= ResolutionMonitor.CurrentResolution: The current Resolution (or the resolution which has been
detected the last time)
In the Editor it is the selected resolution of the main game view window. This might be different
to Screen.width and Screen.height.

= ResolutionMonitor.CurrentDpi: The current DPI (only tracked for changes inside the editor)
The scale of the main game view window is affecting the DPI inside the Editor. Scaling of the
game view can be used to simulate different DPI values.

The Resolution Monitor automatically keeps track of resolution changes inside the Editor. All
MonoBehaviours of the scene which implement the interface IResolutionDependency will be

automatically notified about the Resolution Change.

If you want to have the same behavior in the final build, you need to create an Ingame Resolution
Monitor.

16
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7 INGAME RESOLUTION MONITOR

The Ingame Resolution Monitor is a simple MonoBehvaiour which triggers the logic of the Resolution
Monitor in-game. If the user can change the Resolution inside of your game, you should use it.

To do so, call the following code once at start of your game:

IngameResolutionMonitor.Create() ;

Once created the Ingame Resolution Monitor will not be destroyed anymore. So make sure to create
only one at the beginning and not more.

Note that the ResolutionMonitor.CurrentResolution and ResolutionMonitor.CurrentDpi are equal to
Screen.width / Screen.height and Screen.dpi during runtime.

8 |RESOLUTIONDEPENDENCY

If you want to add your own script which should update itself whenever the resolution changes,
implement IResolutionDependency. You will then need to implement a method called
"OnResolutionChanged()". Trigger your update stuff there. Note that you probably also need to perform
the same logic in your OnEnable() method to make sure it is also calculated when the scene is opened
and the resolution has not changed.

The Resolution Monitor will update your MonoBehaviour then automatically when the resolution
changed.

17
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The following code is an Example how the IResolutionDependency can be used (this example logs
whether the screen is in Portrait or Landscape mode):

using TheraBytes.BetterUi;
using UnityEngine;

public class OrientationTracker : MonoBehaviour, IResolutionDependency

{

// Called by Unity

private void OnEnable()

{
// Check the resolution when the object becomes active
LogOrientation();

}

// Implementation of IResolutionDependency
public void OnResolutionChanged()
{
// Check the resolution after it changed
LogOrientation();

}

// Logs the orientation of the current resolution (Portrait / Landscape)
private void LogOrientation()

{ Vector2 resolution = ResolutionMonitor.CurrentResolution;
if (resolution.x < resolution.y)
¢ Debug.Log("Portrait");
}
else
{
Debug.Log("Landscape");
}
}

18
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Editor Windows

9 SNAP ANCHORS WINDOW

The Snap Anchors Window can be opened from the menu bar of Unity under "Window > Thera Bytes >
Snap Anchors".

9.1 BACKGROUND

To really work resolution independently you should never use constant pixel sizes anywhere. Instead all
measurements should be done with "percentages of the screen". To achieve this you should use
Anchors instead of position and size values in pixels. Anchors describe the top, left, bottom and right
anchor of an object in relative coordinates (relative to it's parent). uGUI comes with an anchoring
system which allows exactly this. However, the predefined Anchoring settings often doesn't fit the
requirements, so you have to setup the anchors by hand which can be really annoying. The Snap
Anchors window allows you to adjust the anchors in the most used way by just clicking a button.

9.2 WORKFLOW

Add an Ul element to a canvas in while working with the optimized resolution. Move and resize the
object as you want (but avoid it to scale or rotate it). When you are ready click the big button of the
Snap Anchors Window which will change the anchors of the object but keeps its position and size.
Change the resolution to see how the objects position and size is affected.

You can also select several Objects and apply the anchoring to all of them. Note that only anchors of

selected objects will be adjusted. Their children keep their previous anchoring as long as they are not
selected as well.

19
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Snap Anchors

Border Faoint

It is also possible to to snap only the horizontal Anchors (button on bottom) or the vertical anchors
(button on left) and keep the other axis as it were before.

Keep in mind that the anchors are always relative to their parents. If the parent doesn't change its size,
the anchors will be irrelevant. So, make sure that the parents are anchored correctly as well.

For some objects anchoring doesn't work as expected. This is the case for objects where the anchors are
changed inside the code. Such an object is the Handle of a Slider for example.

9.3 MODES

There are three modes how to snap the anchors which can be selected at the top of the window
(Border, Point, Pivot).

The Border mode is the most important and probably used more than 90% in comparison to the others.
9.3.1 Border

In Border mode the Anchors are snapped to the bounding of an object. This eliminates any pixel-
distances and converts them to percentages relative to the parent. If the parent changes its size (e.g.
due to a different resolution), the anchored object will change its position and size relative to that
change.

9.3.2 Point
The Point mode adds some extra options to the window. It sets the anchors to a relative point of the

selected object or its parent (if "Point in Parent Space" is selected). The "Choose Point" Button opens a
popup where one of the most used options can be selected.

20
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This option doesn't eliminate pixel distances. It is most likely used to only set the horizontal or vertical
anchors and set the other axis in Border mode.

Border

9.3.3 Pivot
The Pivot mode sets the Anchors to the current position of the pivot point of the selected object.

This option doesn't eliminate pixel distances. It is most likely used to only set the horizontal or vertical
anchors and set the other axis in Border mode.

10 Pick REsoLuTION WINDOW

The Pick Resolution Window is a shortcut to change resolutions with one click. When working with
different resolutions it can be very annoying to use the resolution drop down of the game view all the
time. It is a lot faster to just click a button which is not hidden inside a drop down.

The Pick Resolution Window can be opened from the menu bar of Unity under "Window > Thera Bytes >
Pick Resolution".

21
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Pick Resolution

— 16:10
— 16:3

= Standalone (1024

| © FullHD Portrait (1080x1920)
KGA Portrait | 2

| @ 4K Paortrait (2160

In that window you can find all the resolutions and aspect ratios which can be selected. They are the
same as in the drop down of the game view.

With default settings there is a horizontal or vertical bar at the beginning of each entry name indicating
if the entry is for landscape or portrait mode. Entries which are defined by the user have also a smiley

indicator before the name '=.

If a resolution matches the optimized resolution specified in the Resolution Monitor object, it is
displayed in italics.

The currently active resolution of the main game view is displayed in bold.

10.1 SETTINGS

the very first control of the Pick Resolution Window is a drop down to change some settings. These
settings are saved and loaded between the sessions.

22
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Pick Resolution

# Settings

# Resolution Filters

~  Free Aspect
~  Portrait ()

~ Landscape (m ]

~  Builtin

'  Custom (2]

& Cptions

Text Options »
Style »
Layout »
Refresh List

10.1.1 Resolution Filters

With the Resolution Filters you can hide Entries from the list. This can be handy if you only work in one
orientation or want to use only your own resolution entries.

The Filter options are:
*  Free Aspect: Should the "Free Aspect" button be visible or not?
= Portrait: Should Portrait resolutions be in the list?
* Landscape: Should Landscape resolutions be in the list?
= Builtin: Do you want to have the predefined entries in your list?
»= Custom: Do you want your own created entries in your list?

The filter options can be checked and unchecked to show or hide the respective entry.

Note that all filter conditions must be fulfilled to show an entry. An exception is the "Free Aspect" entry.
It is not considered as builtin nor as custom.

10.1.2 Options
There are some options which allows to modify the look and layout of the window.
10.1.2.1 Text Options

Text Options define what you see on the buttons. The upper three options are for the actual text:

23
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= Name and Size: Displays the Label of the entry as well as the resolution or aspect ratio (e.g. "My
Favorite Resolution (320x240)"

= Name: Displays only the Label of the entry — if the label has no text, the resolution / aspect ratio
is displayed instead (e.g. "My Favorite Resolution")

» Size: Displays the resolution / aspect ratio without the label (e.g. "320x240" or "4:3")

The option "Orientation Hint" shows or hides horizontal or vertical bars in front of each entry to
indicate if an entry is in landscape or portrait mode.

The option "Mark Custom" shows or hides a smiley in front of custom entries to indicate that the user
created it.

10.1.2.2 Style

You can use Small or Big style. Big style may not look as good as the small style but the buttons are
easier to click and separated more clearly from each other.

10.1.2.3 Layout

The Buttons can be ordered next to each other (Horizontal) or below each other (Vertical).

The horizontal layout can be placed nicely above or below the game view. This way it doesn't need much
space and is close to the area it affects.

10.1.2.4 Refresh

If you added, deleted or edited a resolution it is not immediately put into the Pick resolution window. To
have it there just click Refresh.

In very rare cases some entries display the wrong resolution. A click on Refresh should resolve such a
problem.

24



